Accounts Payable Procedure
Monday

Collect all Invoices that should be processed this week – this includes all invoices that have been received to date.  These Invoices will be located in the following areas:  

Invoice Tray (top stacking tray labeled “Invoices” at Accounting Technician’s desk)
A/P Bin (downstairs in Production Rm)
Accounting Technician’s Inbox
No Match Folder (Invoices that did not have a match the week prior need to be re-matched, this folder is kept in the ‘INCOMPLETE’ section of the portable black filing bin (also known as Rover II) located next to the Accounting Technicians desk)
Prepare Rover II for the coming week by moving all Invoices forward (i.e. Move everything from the ‘DUE next week’ folder into the ‘DUE this week’ folder, ‘DUE in 2 weeks’ into ‘DUE next week’, etc.)  Also, go through all Contract Summaries and Invoices in the back of the ‘INCOMPLETE’ section that are Due Dated for the coming Friday and place them in the ‘DUE this week’ folder.  Remove the ‘Match’ and ‘No Match’ folders from the INCOMPLETE section as they will be used with the collected Invoices above.  The ‘HOLD’ and ‘CREDITS’ folders stay where they are.
Invoice Preparation

All invoices must be prepared for payment, this preparation includes the following:

1. Highlight the Invoice #

2. Highlight the Invoice Date

3. Check to see that the Invoice does not include any Previous Balances.  If a previous balance is present highlight the previous balance and question mark.  If the balance is current, continue to step 4.

4. Check the invoice for any discount options and terms offered by the Vendor.  If we can meet the terms, calculate the discount amount on a calculator ticker tape, and Highlight this amount.  If there are no discount options, continue to step 5.

5. Check to see that the Invoice includes Sales Tax (sales tax is not applicable to Labor charges) If the Invoice does not include Sales Tax, flag and write “Tax?”) If the Invoice is taxed properly, continue to Step 6.

6. Highlight the Invoices Amount Due.
7. Stamp each invoice with the RED Accounts Payable Stamp.

8. Due Date the Invoice:  


To Due date an invoice find the due date or terms of the invoice.  If no terms are indicated use 30 days from the date of the invoice.  Choose the Friday prior to this date if it falls on a Thursday or later.  Choose two Fridays prior to this date if it falls on any day earlier than Thursday.
9. Place Invoices into the following 3 categories for Matching and Coding: Utility Invoices (Electrical, Gas, Telephone, Cellular, Waste Disposal, Security and Internet Services), Standard Invoices, Invoices greater than $1000)
Matching & Coding
All invoices must be matched to any back-up on file.  The categories above have different requirements for back-up documentation, thus, are handled separately below.  Back-up documents are filed in the small black portable file cart (otherwise, known as ‘Rover’) located next to the Administrative Services Office Assistants desk.

Invoices greater than $1000…
1. Invoices greater than $1,000 need Dept Head approval.

2. If the dept head approval is missing, place the invoice in the “No Match” folder for routing.

     Invoices greater than $2,500… 

1. Invoices greater than $2,500 should be matched with a Purchase Order or a Contract Summary.  These back-up are located in Rover in the ‘Tan’ colored section and are filed alphabetically by Vendor.  

2. Check to see that the PO/Contract Summary accurately reflect the Invoice.  
3. If the Purchase Order is being fulfilled completely attach the original to the Invoice, otherwise, make a copy of the PO/Contract Summary and attach that to the Invoice.
4. Complete the PO # in the RED A/P Stamp area on the invoice or write “c/Contract”.  Also, mark “c/PO” or “c/Contract” on the Dept Head signature line.

5. Copy the description from the PO or the Finance Use Only area of the Contract Summary on the Description line in the RED A/P Stamp area on the invoice.
6. Copy the Account # from the PO/Contract Summary into the RED A/P Stamp area on the invoice.

7. If the Contract Summary requires Invoice tracking, place the Invoice in the ‘No Match’ folder for routing.  Also include all Invoices for which you could not find a PO or Contract Summary.

8. All Invoices that where successfully matched should now be added to the Standard Invoice pile.

Contract payments

1. Verify that the contract summary is initialed by Sheri.

2. Put a copy of the initialed summary with the invoice then route the invoice in the purple folder for any tracking sheet.

3. Check the contract folder in “Rover” in front of the Tan colored section.  Any invoices that are being held for contract problems will be in this file.  There is also a “Contract On-Hold” list that Sheri provides with the most current on top.  Any vendor on this list will not be paid.  Everything in this file should have notes attached as to why they are being held.
     


Standard Invoices…

1. Standard invoices should be matched with a packing slip or shipping document.  These back-up documents are located in Rover in the ‘Green’ colored section and are filed alphabetically by Vendor.  *Note: Vendors that have a folder denote Vendors paid by statement rather than Invoice.

2. Most invoices include an Order # or Invoice # that is used to match the Packing Slip with the Invoice.  However, in some cases you will need to go by the date, items, quantities, and prices.

3. Check to see that the packing slip accurately matches the Invoice and that it is coded and approved.

4. Copy the description from the packing slip onto the Description line in the RED A/P Stamp area on the invoice.  *Note: Descriptions should match the description format from previous invoices for that Vendor (refer to the Vendors Activity Detail in Fundware or to the Vendor’s Accounts Payable folder).
5. Copy the Account # from the pack slip into the RED A/P Stamp area on the invoice.

6. Mark “c/(” on the Approval line of the RED A/P Stamp area of the invoice if the packing slip has been approved by an authorized approver.  If the packing slip has not been properly coded and approved, place the invoice in the ‘No Match’ folder at this point.

7. Place all Invoices for which you could NOT find a Match, or for which the Pack Slip did not match accurately, in the ‘No Match’ folder.
8. Place all Invoices that were successfully matched in the ‘Match’ folder.

Utility Invoices…

1. Utility Invoices do not require a back-up document because they are paid monthly.  These Invoices are coded and approved by the Administrative Services Dept.

2. Use the red binder located in the upper bin of the Accounting Technicians desk to code all Utility Invoices.

3. Find the list sheet that corresponds to the Utility Invoice.  Locate the Account # on the Invoice and then on the Utility list. Copy this account # to the RED A/P Stamp area on the Invoice.

4. Complete the Description line in the RED A/P Stamp area on the Invoice.

Tuesday

Preliminary Review

The reviewer should check the following:

1. The invoice is accurately matched (The packing slip should include all items that are on the Invoice, if any items on the packing slip are missing, the packing slip should be copied and re-filed noting the items that have been paid)
2. The invoice is coded (check to see that the code makes sense)
3. The invoice is approved (the individual signing off on the invoice must be an authorized approver)
4. The invoice is either under $1000 or includes an approved Purchase Order, Contract Summary, or Travel Requisition.
5. The Invoice does not include any previous balances and/or past due amounts.

6. The Invoice is for a current time period

7. The copied account # and description are completed and correct

8. The invoice includes Sales Tax.  

If Sales Tax is not included, either contact the Vendor for a revised Invoice (usually those Vendors located in CA or NV), or calculate Use Tax – Debit the expense account for the Invoiced Amount plus 7.875% and Credit 01-00-00-2080 for the Tax Amount.   *Note: Shipping is not taxable, however, Shipping & Handling is taxable. 
If any invoice does not meet the criteria above, it should be routed to the appropriate approver along with all the Invoices located in the ‘No Match’ folder.  The reviewer may also review the Invoices in the ‘No Match’ folder to confirm that they should be routed.  The reviewer may be aware of Purchase Orders or Contract Summaries in progress or issues related to that particular invoice.  *Note: For Vendors paid by statement, only the individual invoices missing authorization, a copy obtained from the vendor, or a copy of the statement highlighting the missing transaction should be routed.
Routing

The ‘Purple’ Routing folders are located in the sorting racks at the Accounting Technicians desk.  There is one folder for every Authorized Approver.  Once the Invoices have been reviewed and it has been determined that routing is necessary they can be placed in the appropriate authorized approvers folder.  Folders should be delivered to each individual with the exception of the Public Works supervisors who’s folders can be placed in the ‘Public Works’ mail bin located in the Production Room.  If the folder is routed to someone other the person named, such as an administrative assistant, this is indicated on the inside front cover.  The deadline for routing is Noon or midday on Tuesdays.  This gives approvers enough time to process and return their folders by the Wednesday – 5:00 pm deadline.  

*Note:  If Monday is a holiday the routing deadline is pushed back to Tuesday by 5:00pm.  If Friday is a holiday the routing deadline is moved forward to Monday by 5:00pm.
Following are the most common reasons an invoice would need to be routed:

· Missing or does not match its Packing Slip

· Missing or does not match a Purchase Order or Contract Summary

· Missing an Account #

· Missing an Authorized signature

· Is greater than $1000 and must be signed by a Dept Head

· Invoice needs to be tracked under a Contract Summary

Wednesday
Travel Requisitions
The deadline for Travel Requisitions (TRs) is usually Wednesday by Noon.  Anytime after this is a good time to process them.  As TRs come in they are placed in the ‘TRAVEL REQs IN’ Folder located in the sorting rack on the Accounting Technicians desk.  Separate the Travel Requisitions by Advances (White) and Reimbursements (Green). The following outlines the steps for processing the TRs:

Advances…

1. Check to see that the Travel Requisition is coded and approved.
2. Determine how many checks will need to be cut for items listed in the ‘Advance’ column.  Make a mark for each check needed at the bottom of the TR above the word ‘White’

3. If anything is listed in the ‘Town Credit’ column make a mark next to the word ‘Yellow’ at the bottom of the TR.

4. At this point anything listed in the Reimburse column is considered an estimate and does not require any action.
5. Take each charge on the TR and make sure that appropriate back-up documents are attached.  The back-up must include documents justifying the reason for travel (i.e. Conference agenda, class outline, etc.) and must be specific and include the correct dollar amounts.  Make a check mark next to each amount if the back-up is included and complete.  If any back-up is missing, contact the Traveler or the administrative assistant for the Traveler, and request the documents.

6. Check to see that the appropriate Per Diem amounts are being used according the trips destination.  The High/Low designations are located on a tab on the Travel Requisition Form located at S:\Administrative Services\Purchasing\Forms\Travel Requisition Form.xls  

7. Check to see that the meals being claimed make sense according to the departure and arrival times.  (i.e. Breakfast for Travelers leaving prior to 7am and dinner for Travelers arriving back after 7pm).  Also make sure the travel times make sense according the beginning and ending times of the reason for travel.
8. Due Date the TR in the lower right hand corner ‘For Office Use Only’ area.  TR checks are cut the Friday prior to Travel for any Advances paid to employees. (PD advances are paid two weeks ahead.  PW advances are on a case by case basis.) Vendor checks are cut the Friday of submission.  You may need to squeeze in more than one due date.  Complete the description for any checks that need to be cut.  Advances are described “Travel Adv – TR#XXXX and Vendor Checks are described by what the payment is for and the Travelers last name (i.e. Training – Smith)

9. Note any special instructions located anywhere on the TR form.  Make a flag for any special delivery instruction.  If appropriate make an extra ‘Yellow’ mark at the bottom of the TR if any credit card charges were placed on any cards other than the Travelers or if any charges will be billed by a Vendor.

10. Make a copy of the TR for every mark you placed at the bottom of the TR on the appropriately colored paper.
11. Attach the back-up documents for each charge with the appropriately colored copy of the TR. (white=Advance, Yellow=Town Credit, Green=Reimbursement)

12. On the white Advance copies, highlight the Payee, TR#, TR due date, and TR description and place the white Advance copies in the appropriate “DUE…” folder in Rover II.

13. On the yellow Town Credit copies, highlight the name of the credit card holder and file in the ‘Green’ credit card charge folders located on the sorting racks at  the Accounting Technicians desk.  Or highlight the name of any Vendors sending a bill and file under the Vendors name in Rover I.
14. File the Original copy in the ‘Travel Reqs – In Progress’ folder located in the sorting racks on the Accounting Technicians desk.

Reimbursements…
1. Locate the TR # in the upper right hand corner of the TR.  Pull the Original TR from the ‘Travel Reqs – In Progress’ folder located in the sorting racks on the Accounting Technicians desk.
2. For every charge duplicated on the ‘Green’ copy mark an ‘x’ indicated the item has already been processed.

3. If there are charges without an ‘x’ in the Town Credit column place a mark at the bottom of the TR above the word ‘Yellow’.  For any charges in the Reimburse column place a mark next to the word ‘Green’ at the bottom of the TR.

4. For every charge that does not have an ‘x’, make sure that appropriate back-up documents are attached.  Remember that back-up documents must be specific and include the correct dollar amounts.  Make a check mark next to each amount if the back-up is included and complete.  If any back-up is missing, contact the Traveler or the administrative assistant for the Traveler, and request the documents.

5. Check to see that the appropriate Per Diem amounts are being used according the trips destination.  The High/Low designations are located on a tab on the Travel Requisition Form located at S:\Administrative Services\Purchasing\Forms\Travel Requisition Form.xls  

6. Check to see that the meals being claimed make sense according to the departure and arrival times.  (i.e. Breakfast for Travelers leaving prior to 7am and dinner for Travelers arriving back after 7pm).  Also make sure the travel times make sense according to the beginning and ending times of the reason for travel.

7. Due Date the TR in the lower right hand corner ‘For Office Use Only’ area.  Reimbursement checks are cut the Friday following submission, given the TR was submitted prior to the Thursday – Noon deadline.  Complete the description – Reimbursements are described ‘Travel Reimb – TR#XXXX’.

8. Note any special instructions located anywhere on the TR form.  Make a flag for any special delivery instruction.
Purple Folder Processing

The purple folders will come back in spurts.  As many as have been returned should be processed on Wednesday before Noon.  The deadline to give the payables that are ready for payment to the Administrative Services Manager is Noon on Wednesday.  To process the purple folders, follow steps 1-8 under Tuesday, Preliminary Review.

Final Review

Once the payables have been reviewed, you can prepare them for final review by the Admin Services Manager.  All payables in the ‘DUE this week’ folder should be sorted by posting date.  To sort the payables by posting date use the colored dividing sheets located in the sorting rack above the Accounting Technicians desk.  Invoices should be sorted into piles by the period of time covered by the Invoice.  If a period of time is not applicable, use the received date – usually located on the packing slip.  If no received date exists, use the Invoice date.  If you have any posting date questions, make a stack and use the ‘Posting Date ?’ colored dividing sheet.  Submit the sorted and divided stack to the Admin Services Manager.
Thursday/Wednesday
Data Entry
The Admin Services Director will give the payables to the Office Assistant for entry after they have been reviewed.  
Data entry into Fundware:


1.  Check business date at the top left of the screen.

      If you need to change the business date, do so under the Edit tab.  


2.  Enter the individual invoices under Obligations, Invoices.


     After the first invoice in entered, there will be a “New” folder.  All invoices for the                      


     same date should be entered here.


3.  On the Header tab start typing the Vender name.  Once the name comes up, check 

      the address to make sure it matches.  


4.   Enter the description from the red stamp.


5.   Enter the total amount of the invoice.


6.   Enter the invoice date.


7.   Enter the due date.  This is the date that the checks are being cut.  Usually Friday of 


      the current week.


8.   On the Data Items tab, enter the invoice number.  If this is a TR that # should 



      go in the Purchase Order # field.

9.   Go to the Detail Lines tab.  If this is a regular account, enter the account # and          
      amount under the New tab.  If this is a distribution account, enter the information 

      under the Auto tab.  If it is a distribution account, the invoice amount entered on

      the first tab must match the amount to be distributed.  

10. Click OK. 

After each posting date someone other than the data entry person should review the list and post the Invoices.  

The reviewer should check the following items:
1. Check the descriptions for accuracy and errors.
2. Check to see that the Vendor used for each Invoice makes sense with the description.
3. Check to see that every Invoice has an Invoice date and Invoice # entered with the only exceptions being - Travel Requisitions – however, the TR# should go in the Purchase Order # field, Vendors paid by Statement that have multiple monthly accounts – all other statement vendors should use the Month & Yr (MMM – YY) as the Invoice #, and Check Requests.  If an Invoice doesn’t have an Invoice #, try to use the period covered (i.e. MMM-YY or QE M/YY or PE M/D/YY), otherwise, leave the Invoice # blank.
4. Check to see that all the due dates are correct.

5. Very Important!  Check to see that the Posting Date is correct and post the Invoices.

A/P Deadline
At 8:00 am Thursday a final check of the A/P bin in the production room should be made and the bin turned upside down and the CLOSED sign (located underneath the bin posted).  All remaining purple folders should be reviewed at this time.  Repeat steps 1-8 under Tuesday, Preliminary Review, and the instructions under Wednesday, Final Review.  Use the second set of colored dividing sheets not used on Wednesday.  Give the final set of payables to the Admin Services Director as soon as possible after Noon on Thursday so that the payables can be entered and ready for payment on Friday a.m. – you may need to do some entry on Friday a.m.
Friday
Once all of the Invoices have been entered you are ready to cut checks.  The process for cutting checks is as follows:
Make a final check that all payable have been included: Double check the INCOMPLETE section of Rover II, this includes the ‘DUE this week’ folder, the ‘HOLD’ folder, the ‘No Match’ folder, and the ‘Credits’ folder. Check to see if there are any Invoices that need to be handled this week or if any existing credits can be used against this weeks payables.  Also, check the ‘Travel Reqs IN’ folder to be sure all Travel Requisition needing payment were processed.
Cut Checks
Preliminary Check Register:

1. In the Accounts Payable module of Fundware, make sure the business date is set to today’s date.
Note: Clarify that all Invoices have been posted and that there are no invoices in the ‘New’ or ‘Edited’ folder under ‘Invoices’. If more than one user has been entering Invoices make sure you check in the other users ‘New’ and ‘Edited’ folders as well.  Put list in Vendor Name order.  Check the due date list to make sure all the dates are the current week. Check to make sure there are no credit payments not offset by other invoices.  If so, Edit and Change their due dates to the next weeks date.  
2. Select all Invoices in the Invoices folder by holding down the shift key.

3. Select ‘Mark for Pay’.  In the first window all the invoices should appear (if they do not – you may not have the business date set for today.  Select Bank of the West Operating account.  Authorize with initials.  Click ‘OK’– this will move all of the invoices into the ‘New Mark’ folder under ‘Mark for Pay’). 
4. Open the ‘New Mark’ under ‘Bank of the West Operating’ and under the ‘New Mark’ folder, Click Post, and Click ‘OK’ – all invoices will now move to the ‘Marked for Payment’ folder

5. Open the ‘Marked for Pay’ (already open) folder and Click the ‘Check Writing’ button.  Click the Produce Register button.  You will be asked if it is OK to overwrite last weeks Preliminary Register.  Click ‘YES’ 
6. Close the Check Writing window.

Open the Print Manager under the File Menu and print the Preliminary Check Register report OTPREG.L01.  This report will be located in the Data folder or in your personal folder if one has been created for you.  Under the Mode Menu make sure that ‘Classic’ is chosen.  Print the report on the default printer (Acct HP 5100)
7. Check the stamped and sorted Invoices against this Preliminary Check Register.  
Note: It is a good idea to have the preliminary checked by someone other than who performed the data entry.  Make sure all Invoices have been entered, with the correct Vendor, and the Correct $ amount.  Look for warnings on the preliminary report.  If any Invoices need to be added, add them now.  If any corrections need to be made – you must unmark, post, and edit or VOID and reenter the Invoice.  Pose in UnMark from Bank in Check writing window. 
8. After the Preliminary Report has been reviewed the report is filed in the Accounts Payable Check Register folders.
Print Checks:
When all Invoices are reviewed and correct, you are ready to cut checks... 
1. In the ‘Mark for Pay’ folder, reopen the Check Writing window and select the ‘Produce Checks’ tab.

2. Verify the information in the window (check date) and take note of the # of checks that will be cut.  Click the ‘Produce Checks’ button. 

3. Close the Check Writing Window.
4. Under the File Menu open the Print Manager and open the Check file otckxxxx.L01.  This file will be located in the Data folder or your personal folder if one has been created for you.  Choose the ‘Windows’ mode from the Mode menu.  Choose Print from the File Menu.  A Print window will appear.  Choose the ‘AP ToT – SFS’ template in the Form field.  Check to see that the ‘Review File before Printing’ checkbox is checked and click OK.
Note:  The file will NOT go immediately to the printer at this time, but the Windows version of the checks will display.    
5. In the ‘Pgs to Print’, enter 1 and the # that you noted above.  You may click on any check # to view the check as it will print.  The last check # in the list is not an actual check and should have a red “x” next to it instead of a green “√”.
6. The check stock is located in Mary’s office.  Count out the appropriate # of checks or use the following formula:  Subtract 1 from the # of checks you noted above and add this # to the top check #.  This will give you the ending check #.

7. Place the checks in the Manual Feed tray of the printer you will be using. Place the checks in the printer, face up, top to the right.

      Note: Make sure you warn others using the same printer to NOT print while you have the check stock in the printer.

8. From the File Menu choose Print.  Select the appropriate printer.  Click the ‘Print’ button.
9. If any of the checks have to many items to fit on the actual check stub there will be a second page printed.  This page will be titled OTOVFLO.  Check this file.  If there is any overflow check stubs, print this file and make two copies.  One to go with the check and the other to go with the copy.

Log Checks:
1. All checks are now located in the ‘Cut Checks’ folder under ‘Bank of the West Operating’.  In the ‘Cut Checks’ folder, open the Check Writing Window and choose the Log Checks tab.  
2. Select all the checks that appear in the window by holding the Shift key.  Next to the ‘Assign’ button, enter the check # of the first check and click Assign.

3. Finger through the checks and make sure the check #s have been assigned correctly.

4. If so, click ‘Post’.
Final Check Register:

1. Under the File Menu, open the Print Manager and print the Final Check Register Report OTREG.L01 located in the Data folder or your personal folder.  
2. Choose Print from the File menu and print the report.  You will be asked if it is OK to overwrite last weeks Report.  Click ‘YES’.  Click ‘OK’.   
3. Close the OTREG.L01 file.

4. Reopen the file by choosing the ‘Open’ Icon on the toolbar of the Print Manager, select the OTREG.L01 report again. Right click on the file name and choose ‘Copy’ from the menu.

5. In the Browse drop down menu at the top of the window, choose Accounting (D), Saved Files from Print Queue, AP… 

6. Right click anywhere in the white space that appears and choose ‘Paste’ from the menu.  Right click on the filename that appears and choose ‘Rename’ from the menu.  Rename the file in the following format “AP MMDDYY”.  Click Enter.
Note: The filename will disappear, you can see the results by choosing ‘All Files’ in the ‘Files by type:’ field.

7. Close the Print Manager.
8. Deliver the Final Check Register to the Accounting Technician (Barbara) to be used for the ‘Cash Log’ procedure.

Cash Log: 
1. Open the Cash Log – see the Admin Services Manager for the Password.  
2. On the tab for the current month, enter a new line with the date, description “A/P”, the check # range, and the mount of the check run.  The amount can be found on the Final Check Register about mid way and is labeled ‘Report Total’.  Make sure this amount is entered as a negative amount.
3. Clarify that your check #s start with the check # following the last check logged. 
4.  Report to the Admin Services Director if the Cash Log is a negative amount.

Check Preparation

5. Make 1copy of each check.

6. Remove the Bottom stub of each check.

7. The check stubs are filed in the Numerical Check file located in the current years A/P cabinet near the Office Assistants desk.  
8. The copy of the checks are matched to their corresponding invoices.  Staple each check copy to the top of it’s corresponding back-up invoice(s).  Any items paper clipped to the invoice should be re-paper clipped to the stapled materials to be mailed with the check.  The original check is attached to the top of the stack with a paper clip.  
9. The checks are given to the Administrative Services Director for signature.

(Tony, Alex, and Dan Wilkins also have signing authority)

After the checks are signed and returned from the Admin Services Director…

10. The checks are now ready to be prepared for mail.  

11. Verify that each check has been signed.

12. Remove the check from its copy and stapled back-up materials and any other items paper clipped that should be mailed with the check.
13. Insert the check and accompanying remittance materials in a windowed AP envelope.  You Do NOT need to seal the envelopes.
Note:  if the items require a larger envelope a Town of Truckee windowed envelope, Coin, or Letter sized envelope can be used.

14. Separate the checks that can be hand delivered, as well as, any checks that require special handling, from the checks that must be mailed.
15. Using the postage meter located in the Production Room, seal & post each envelope.  See the instruction manual located above the postage meter for detailed instructions.

16. Deliver all other checks to the appropriate person and/or department.

17. The stack of check copies/back-up, and the Final Check Register, are delivered to the Town Manager, or authorized signer, for review.

You are done!
